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LICENSE & WARRANTY 

This software is a proprietary product and is protected by copyright. You may duplicate 
it for backup protection but not, either in whole or in part, for any other purpose. It may 
be used by more than one machine but only for business related to the licensed 
property. 

If this software fails to perform to your satisfaction within 30 days from the date of 
purchase, Innsoft, Inc. will repair the defect or refund the purchase price of the software. 
You agree that your sole remedy is a full refund of the purchase price.   

Innsoft, Inc. makes no warranty, expressed or implied, including fitness for a particular 
use, regarding this software. Innsoft, Inc. shall in no event be liable for any special, 
incidental, consequential or other damages resulting from any defect in the software.   

This software is licensed to a physical location, not a person, corporation or other 
legal entity. Under no circumstances will the license be transferred to another physical 
location. 
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CUSTOMER SUPPORT 

Customer support 

Innsoft, Inc. 

Sales: (800) 950-8995 

Technical Support: (503) 643-8162, option 2 
(7:00 AM – 4:00 PM, Pacific Time, Monday – Friday) 

Unless you are using a demo, a valid service contract is required to receive technical 
support. 

After-hours emergency support is available from 4:00 PM – 11:00 PM, Monday – Friday; 
7:00 AM – 11:00 PM, Saturday – Sunday (Pacific Time).  

There is an additional fee for after-hours emergency support. 

Fax: (503) 641-6537 

Email: info@innsoft.com 

Website: www.innsoft.com 

ACKNOWLEDGEMENT 

We would like to thank all of the property owners, managers, and staff who have 
contributed their suggestions and ideas for making Innformer™ a better and more useful 
product. Your invaluable help in the development and testing of Innformer is greatly 
appreciated.  

  

http://www.innsoft.com/
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INTRODUCTION 

Innformer™ is an easy-to-use marketing tool that has been specifically designed for use 
with the Check-Inn® program and works on any Windows-based computer. The program 
installs in minutes and links directly to the Check-Inn lodging software.   

Innformer is designed to help your property:  
 Create direct marketing labels 
 Create mail merge letters* 
 Create marketing reports and charts 
 Modify Check-Inn guest records 

Innformer lets you select your list of customers based on many criteria. These criteria 
include, but are not limited to, the number of guest nights, number of guest stays, room 
rate, ZIP code, and arrival date. Innformer increases your revenue flow by allowing you 
to let your valued guests know about property specials and thank them personally for 
their continued patronage. The reports and charts in Innformer help your manager 
determine which marketing techniques work for your property. 

If you have problems running Innformer, consult the corresponding section of this 
manual. You may also refer to the Frequently Asked Questions section at the end of the 
manual, which contains answers to the most common questions. Once you are running 
Innformer, you may press the F1 key at any time to receive help throughout the 
program. The help key allows you to view tips, hints, and directions. If you still cannot 
find a solution to your problem, please call Technical Support: (503) 643-8162, option 2.   

*Microsoft Word 97 or better is required for mail merge functions. 

IMPORTANT! Your property name and personal code number must be entered in the 
“Name and Address” section of Change Settings in the Check-Inn program for the 
Innformer software to work. The property name in Innformer is taken directly from 
Check-Inn. You cannot change the property name in the Innformer program. Your 
property name and code number are found near the middle of your invoice under the 
Information section. The property name and code number must match the invoice 
exactly.  
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Getting Started 

INSTALLATION 

There are two ways to install Innformer: 
 From the Innsoft website 
 From a CD 

If you already have Innformer installed, click here to complete the installation process.  

Download and install Innformer from www.innsoft.com 

Please contact Innsoft Tech Support (503-643-8162) for assistance with downloading 
and installing Innformer. 

Install from a CD 

Follow these steps to install Innformer from a CD: 
1. Insert the Innsoft, Inc. CD into your CD-ROM drive.  

After a few moments, a screen should open asking what you want to do.  

2. Click Run setup.exe. 

A screen should open asking which product you would like to install. 

3. Click Innformer.  

a. If you do not have Adobe Acrobat Reader installed on your computer 
you will see the following message: “We are unable to locate a current 
version of Adobe Acrobat Reader. This program is required to view 
program manuals. Would you like to install this program now?”  

b. If you would like to install Adobe Acrobat Reader to be able to view the 
manuals on your computer, click Yes, otherwise click No. 

The Innformer™ Setup Wizard screen is displayed.  

Note: If you do not receive a prompt to install Innformer, please call Innsoft Technical 
Support during normal business hours at (503) 643-8162, option 2. 
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Complete the installation process 

Follow these steps to complete the Innformer installation process, whether you have 
downloaded Innformer from the Innsoft website or installed it via a CD. 

At the Innformer Setup Wizard screen: 

1. Click Next to install Innformer, otherwise click Cancel.   

2. Choose where to install Innformer.  

Note: Typically, this is the C drive if it is a stand-alone computer, but it may be 
another drive if there is a network (for example, F or G).  Innformer defaults to 
the C:\INNFORM directory.   

3. Click Next to install the program to your hard drive, otherwise click Cancel. 

4. Select the Start Menu folder where you would like to create the program’s 
shortcuts, then click Next. 

A summary of your installation choices is displayed.  

5. Click Install to finish installing Innformer, or click Back to change the Destination 
Directory or the Start Menu folder.  

6. Click Finish. 

When you open Innformer 

 When you first open Innformer, it pulls in the Check-Inn guest history, not 
current guests.  

 If you have Innformer open when your guest history in Check-Inn updates, those 
new guests (in history) do not update into Innformer automatically.  

 To update Innformer with the most current Check-Inn information, see Rebuild 
files. 
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MAIN MENU 

IMPORTANT! Close Check-Inn on all computers before you open Innformer.  

Informer’s main menu has eight categories: 
 File 
 Settings 
 Search 
 Edit 
 Labels 
 Merge 
 Reports 
 Help 
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First things first 

Use the Search feature to locate guest records. You can use a variety of filters to 
narrow your search. Once you’ve located the records you need, you can: 

 Change a guest’s record. 
 Create a new guest record. 
 Delete a guest record. 
 Restore a deleted record. 
 Print labels. 
 Create a mail merge document. 
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File 
Use the File menu to:  

 Install an update. 
 Rebuild Innformer’s files.  
 View deleted guest records. 
 Exit Innformer.  
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INSTALL AN UPDATE 

Use the Install Update option to install an update from a CD.  

1. Insert the Innsoft, Inc. CD into the CD-ROM drive. 

If: Then: 

The Innsoft, 
Inc. installer 
starts 

Go to step 2. 

The Innsoft, 
Inc. installer 
does not start 

a. Click File on the main menu. 

 
b. Click Install Updates. 

 
This message is displayed: “Do you want to install an 
update?”   



File  Innformer Setup Guide 

File Settings Search Edit Labels Merge Reports FAQs  
 

If: Then: 

 

c. Click Yes to install the update. 

 

2. Click the Innformer button to start the install. 
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REBUILD FILES 

Use the Rebuild Files option to force Innformer to re-read all of Check-Inn’s guest 
history records and re-create Innformer’s data files. 

IMPORTANT! Check-Inn must be closed on all computers before Innformer can rebuild 
files.  

1. Click File on the main menu. 

 

2. Select Rebuild Files from the File menu. 
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This message is displayed: “This utility will rebuild all of your files. Continue?” 

 

3. Click Yes to rebuild all of your files, otherwise click No. 

 

 

 

  

Note: When you rebuild files, 
your existing (unsaved) 
searches are deleted.  
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VIEW DELETED 

Use the View Deleted feature to look at and restore — if needed — all deleted 
Innformer guest records. 

Notes:  
 Deleted files are no longer available to view or edit once you close the Innformer 

program.  

 Deleting a guest record only affects guest history records. It does not affect 
Check-Inn financial records, nor does it affect Batch History or the Authorization 
Log.  

1. Click File on the main menu. 
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2. Select View Deleted from the File menu. 

 

All files you have deleted are displayed. 

 

3. Click OK. 

  

Remember: You can only view 
files you deleted since opening 
Innformer. Once you close 
Innformer, deleted files are no 
longer available to view or edit. 

 

To restore a deleted record, click 
Edit. See Restore a deleted 
record for more information. 
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4. Click Start to return to a normal view mode.  
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EXIT 

Use the Exit feature to close Innformer. 

1. Click File on the main menu. 

 

2. Select Exit from the File menu. 

 

The Innformer program closes.
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Settings  
Use the Settings menu to configure the information that Innformer needs to operate 
properly. This information includes: 

 Check-Inn Location (required) 
 License Code (required) 
 Printer Selection (optional) 



Settings  Innformer Setup Guide 

File Settings Search Edit Labels Merge Reports FAQs  
 

CHECK-INN LOCATION 

This is the location on your computer where the Check-Inn program is found. The 
default directory for Check-Inn is ‘C:\CheckInn’ on a stand-alone computer, but 
depending upon your configuration Check-Inn may be in a different location. This 
location must be set correctly to allow Innformer to communicate with Check-Inn. 

1. Click Settings on the main menu. 

 

2. Select Check-Inn Location from the Settings menu. 

 

The Settings – Check-Inn Location screen is displayed. 
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3. Click Browse… to search for the Check-Inn directory. 

 

4. Once you have found the correct directory, click OK. 
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5. Click OK to close the window. 
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LICENSE CODE  

You can run Innformer for a trial period of 45 to 60 days in Demo mode using the demo 
code (651335) as your code number. The time remaining for the trial period is displayed 
in the top left-hand corner of the main menu of Innformer.   

 

Once you have purchased Innformer, you need to enter your license code (personal 
code number) in place of the demo code.   

Note: Printing and mail merge functions are disabled during the demo period. 

1. Click Settings on the main menu. 
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2. Select License Code from the Settings menu. 

 

The Settings – License Code window is displayed. 

3. Enter your personal code number as it appears on your invoice under the 
Information section, and press the OK button.  
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If the code is: Then: 

Correct You are returned to the main menu of Innformer with no error 
message. 

Incorrect You will receive this error message: “Invalid Code. Continue?” 

a. Click No and re-enter the code number. 

b. If the code number still does not work, contact Technical 
Support: (503) 643-8162, option 2.   

 

Note:  Your property name and personal code number must be entered in the 
“Name and Address” section of “Change Settings” in Check-Inn for Innformer to 
work. The property name in Innformer is taken directly from Check-Inn. 
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SELECT PRINTER 

Use the Select Printer option to view and change the default printer in Innformer. 

1. Click Settings on the main menu. 

 

2. Click Select Printer from the Settings menu. 

Open 
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The Print Setup screen is displayed. 

 

3. Click the down arrow for the Name field to view the list of printer options. 

 

4. Click to select the printer you want. 

5. Click OK to save the printer savings. 

You are returned to the main menu. 
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Search  
Searching is the first step for any function in Innformer. Searching allows you to select a 
set of working guest records. The guest records are displayed in the right-hand section 
of the main menu.  

You can further refine your search by selecting or clearing the check box to the left of 
the guest record with a click of the mouse. Records that are selected are included in the 
set of working guest records, cleared (unchecked) records are not included.  

Use the Search feature to search by any combination of the following categories: 
 Name 
 Address 
 Stay 
 Other 

You can also use the Search feature to: 
 View a summary of the criteria you have selected. 
 Load previously saved search criteria. 
 Save search criteria. 
 Export search results. 
 Select the guest record fields to display on the main menu. 

From the set of guest records displayed on your screen you can: 
 Create labels. 
 Send letters. 
 Create reports and charts. 
 Make guest record changes.  

The four main search categories in Innformer are Name, Address, Stay, and Other. You 
can use any combination of these categories for every search, or, leave all filters blank 
to see all guest records. Here are some tips for using the Search function: 

To do this: Do this: 

Filter your search 
results  

In the search fields under each category, only include 
information you want to restrict. 

Leave search fields that you do not want to restrict blank. 

Find a partial match in 
a field 

End the field with an asterisk (*). 

For example, if you want to find guests with a last name that 
begins with “SM” enter SM* in the Last field. 

See every guest record 
in the system 

Leave all fields (under all four categories) blank. 

Start a search Click Start. 
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SEARCH BY NAME 

Use the Search by Name feature to restrict your set of guest records by first name, last 
name, and/or company name. 

1. View the Search by Name fields on the main menu. 

 

2. Enter information into the First Name, Last Name, and/or Company Name fields. 

 

3. Click Start. 
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The search results are displayed on the right side of the screen.  
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SEARCH BY ADDRESS 

Use the Search by Address feature to restrict your set of guest records by street 
address, city, state, country, and/or ZIP code range.  

Note: The entry for Zip code consists of two fields. The first field is the starting number 
for the ZIP code range and the second field is the ending number for the range. 

1. Click Search by Address on the main menu. 

 

The main menu displays the Search by Address fields.  
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2. Enter information into any/all of these fields: 

 Street Address 

 City 

 State 

 Country  

 Zip Code  

 

3. Click Start. 

The search results are displayed on the right side of the screen.  
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ZIP code examples 

If you want to see only guest records with the ZIP codes 90405, 90406, and 90407: 
 Type 90405 in the first Zip Code field. 
 Type 90407 in the second Zip Code field. 

If you want to see only guest records with the ZIP code 90405: 
 Type 90405 in the first ZIP Code field. 
 Leave 0 in the second ZIP Code field. 
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SEARCH BY STAY 

 

Use the Search by Stay feature to restrict your set of guest records by: 
 Guest arrival date at the property 
 Number of nights the guest stayed 
 Number of times the guest stayed 
 Guest number and/or room rate 

1. Click Search by Stay on the main menu. 

 

The main menu displays the Search by Stay fields.  
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2. Enter information into any/all of these fields: 

 Arrival Date (If you use this option, you must enter dates in both Arrival Date 
fields.) 

 Nights* 

 Stays* 

 Guest# 

 Rate 

 

3. Press Start. 

The search results are displayed on the right side of the screen.  

For the Nights and Stays fields: 

If you are not searching for a range 
of nights or stays, only enter one 
number into this field.  

For example, if you are searching 
for guests who stayed for 3 nights, 
you would enter a 3 into the first 
Nights field only.  



Search  Innformer Setup Guide 

File Settings Search Edit Labels Merge Reports FAQs  
 

 

Nights examples 

To see records of guests that have stayed two to four nights at the property: 
 Type 2 in the first Nights field. 
 Type 4 in the second Nights field. 

To see records of guests that have stayed four nights at the property: 
 Type 4 into the first Nights field. 
 Leave 0 in the second Nights field. 

Stays examples 

To see records of guests that have stayed two to four times at the property: 
 Type 2 in the first Stay field. 
 Type 4 in the second Stay field. 

To see records of guests who have stayed at the property six times: 
 Type 6 in the first Stay field. 
 Leave 0 in the second Stay field.  
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SEARCH BY OTHER 

Use the Search by Other feature to restrict your set of guest records by: 
 Phone number 
 Remarks 
 “Bad guest” status 
 Complete mailing address 
 Duplicate guest record status 

1. Click Search by Other on the main menu. 

 

The main menu displays the Search by Other fields.  
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2. Enter information into any/all of these fields: 

 Phone # 

 Remarks 

3. Click to select any/all of these check boxes: 

 Bad Guest 

 No Bad Guest 

 Complete Address  

 No Duplicates 
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Click Start. 

The search results are displayed on the right side of the screen.  

 

Examples 

To see this type of 
record: 

Do this: 

Guest records for “bad 
guests”  

Click to select the Bad Guest check box. 

Note: Guest records for “bad guests” are shown in red 
on the main menu. 

Records that are not marked 
as “bad guests” 

Click to select the No Bad Guest check box. 

Records that have a 
complete address (address, 
city, state, and ZIP code) 

Click to select the Complete Address check box. 

One guest record per guest 
no matter how many times 
the guest stayed at the 
property 

Click to select the No Duplicates check box. 

 

In this example, we did a search for 
“bad guests,” so the results are 
shown in red.  
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VIEW THE SEARCH CRITERIA 

Use the Search Summary feature to view the search criteria you have selected under 
the four main search categories (Name, Address, Stay, and Other). 

1. Click Search Summary on the main menu. 

 

The Current Search Options screen is displayed, showing the search criteria you 
have entered.  

 

2. Press Close when you have finished viewing the search information. 
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OPENING A SEARCH 

Saved search criteria can be accessed with the Open Search feature. By quickly 
loading your previous searches, the Open Search can save you valuable typing time. 

1. Click Search on the main menu. 

 

 

2. Select Open Search. 
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The Innformer – Open Search window is displayed. 

 

3. Use the drop-down arrow to select the search you wish to open 

 

4. Click Open to open the search. 

 

This message is displayed: “Would you like to start the loaded search?” 

5. Make a selection: 

 Click Yes to immediately start the search. 

 Click No to revise the search criteria before starting the search. 
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SAVE A SEARCH 

Use the Save Search feature to save a set of search criteria. This can save time in the 
future when you need use the same search. 

1. Click Search on the main menu. 

 

 

2. Select Save Search. 
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The Innformer – Save Search window is displayed. 

 

3. Type the file name of the search you wish to save. We suggest choosing a name 
that clearly identifies the type of search it is.  

For example: If you save a search for bad guests, you might name it “Bad 
guests.”  

 

4. Click Save to save the search. 
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EXPORT A SEARCH 

Use the Export Results feature to save the current set of guest records. The data can 
be saved either in text format, for use in spreadsheet programs, or in Microsoft Word 
format. 

 

1. Click Search on the main menu. 

 

2. Select Export Results. 
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The Export Search Results screen is displayed. 

 

3. Click to select either the Export as MS-Word Datasource or Export as Comma 
Delimited Text check box. 

 

4. Click Select Fields.  
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The Innformer – Select Fields window is displayed. 

 

5. Click to select the check boxes for every field you want to export.  

 

6. Click Done when you’ve finished selecting fields to export. 

  

Click the arrows (< and >) at 
the bottom of the screen to 
see all field options.  
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7. Enter a filename in the Name field. 

 

8. Click Browse to choose a location to save this file. 

9. Click Export to export the current set of guest records as a file.  
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VIEW OPTIONS 

Use the View Options feature to select which fields of the guest record to display on the 
main menu. 

1. Click Search on the main menu. 

 

2. Select View Options. 
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The Innformer – Select Fields window is displayed. 

 

3. Click to select the check boxes for every field you want to display.  

 

4. Click Done when you’ve finished selecting fields to display. 

Click the arrows (< and >) at 
the bottom of the screen to 
see all field options.  
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Edit  
Use the Edit feature to:  

 Change a guest’s record. 
 Create a new guest record. 
 Delete a guest’s record. 
 Restore a deleted record.  

Notes:  
 Any changes make to Innformer are also reflected in Check-Inn’s guest history. 
 You must exit Check-Inn before using the Edit feature of Innformer.  
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CHANGE A GUEST’S RECORD 

1. Locate the record you want to change. 

See Search for information on searching for guest records.  

 

2. Double-click the guest record you wish to modify or click Edit on the main menu. 
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The guest record opens. 

 

3. Make the desired changes to the fields in the guest record. 

4. Click Close. 

This message is displayed: “Would you like to save changes to the guest?” 

5. Click Yes.  
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MOVE BETWEEN GUESTS WHILE IN EDIT 

Use this feature to move between guest records.  

1. Use the search feature to generate a list of guest records. 

See Search for information on searching for guest records.  

 

2. Double-click the guest record you wish to modify or click Edit on the main menu. 
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The guest record opens. 

 

3. Click Previous or Next to move to the previous or next guest record in the guest 
list. 
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CREATE A NEW GUEST RECORD 

1. Click Edit on the main menu. 

 

The Edit Guest Record screen is displayed.  
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2. Click New. 

 

3. Complete the fields on the Edit Guest Record Screen. 

4. Click Apply. 

5. Click Close.  
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DELETE A GUEST RECORD  

IMPORTANT! Deleting a guest record only affects guest history records. It does not 
affect Check-Inn financial records, nor does it affect Batch History or the Authorization 
Log.  

1. Locate the record you want to delete. 

See Search for information on searching for guest records.  

2. Double-click to open the record. 
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The guest record is displayed. 

 

3. Click Remove to delete the guest. 
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This message is displayed: “Are you sure you would like to delete the record?” 

4. Click Yes to delete the record. 

5. Click Close to close the Edit Guest window. 

Note: Using the Remove feature does not remove the guest record from the screen 
until you close the Edit Guest window. 
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RESTORE A DELETED RECORD 

Use this feature to restore a record that you have previously deleted.  

1. Locate the record(s) you want to restore. 

See View deleted for more information. 

2. Double-click to open the record you want to restore. 
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That record is displayed in the Edit Guest screen. 

 

3. Click Restore. 
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A confirmation window is displayed. 

4. Click Yes to restore the record. 

 

The record is restored.  
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Labels 
Creating labels in Innformer from your guest records is a quick and easy process. 
Innformer prints on most laser or inkjet compatible labels including these Avery styles:  

 5160 
 5260 
 5960 
 5970 
 5971 
 5972 
 5979 
 5980 
 8160 
 5161 
 5162   

These Avery styles represent labels that are sized at 1" x 2 
5

8
", 1" x 4", and 1

1

3
" x 4". 

Note: Innformer only supports laser or inkjet compatible labels, not dot-matrix style 
labels. 
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PRINT LABELS 

1. Enter search criteria on the main menu and press Start. 

See Search for more information.  

2. Click Labels on the main menu. 

 

If you have any duplicate or incomplete addresses, you will see this screen: 

 

3. Click Yes. 

If entries are removed that you didn’t expect to be removed, it’s probably 
because the address was not complete. Locate the entry (see View deleted for 
information on how to find and restore deleted files), complete the address, and 
then try again.  
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The Select Label Format window is displayed. 

 

4. Use the drop-down arrow to select the correct label format.  

 

If you: Then do this: 

See your label listed Continue with step 5. 

Do not see your label 
listed 

a. Choose the first label on the list, and click Compatibility. 

 
A list of labels that are compatible with the style you selected 
is displayed. 

 
b. Review the list of results to find the type of label you 

have. 

c. Repeat steps a and b, choosing a new label type each 
time, until you’ve located a label compatible with your 
label type.  
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If you: Then do this: 

d. Click Done. 

 

5. Click Create to view your labels. 

6. Click Print to print your labels. 

7. Click Done. 
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Mail Merge 
Use the Mail Merge function in Innformer to create personalized letters to your guests. 
Mail Merge enables you to use the information from your guest records to customize 
your letters.  

For example, you can include the guest’s name, address, email address, and other 
information that is specific to your guest. Mail Merge allows you to use Microsoft Word 
to write the template letter. This enables you to use the powerful editing and printing 
capabilities available in Word to create personalized documents. Mail Merge also 
enables you to save and load your current set of guest records and your Word 
document for use at a later time. 

IMPORTANT! In order to use the Mail Merge function, you must have a licensed copy 
of Innformer. (Mail Merge does not work with the demo version.) 



Mail Merge  Innformer Setup Guide 

File Settings Search Edit Labels Merge Reports FAQs  
 

CREATE A NEW MAIL MERGE IN MICROSOFT WORD 

1. Enter search criteria on the main menu and press Start. 

See Search for more information.  

2. Click Merge on the main menu. 

 

The Mail Merge window is displayed. 
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3. Click Select Fields. 

 

The Innformer – Select Fields window is displayed. 
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4. Click to select the check boxes for all the fields required to personalize the letter. 

 

 

5. Click Done when complete. 

 

The Mail Merge window (with Step 1 in the upper left) is displayed. 

 

  

Click the arrows (< and >) at 
the bottom of the screen to 
see all field options.  
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6. Enter the name of the file that will hold the set of guest records to be merged, 
and click Next. 

 

The Mail Merge window (with Step 2 in the upper left) is displayed. 
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7. Enter the filename of the Word document to be created that will be the template 
letter to your guests. 

8. Click Finish to start the merge process in Microsoft Word. 

 

After clicking Finish, you will be asked if Innformer should remove duplicate 
records and incomplete addresses. 

 

9. Click Yes. 
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A screenshot stating that Innformer is creating the datasource is displayed.  

 

Microsoft Word opens a blank document. 

10. Write a template letter in Microsoft Word using the Insert Merge Field drop-down 
box to insert merge fields into appropriate places in the document. 

11. Click Merge to. 

12. Select Printer under Merge to. 

13. Click Merge. 

14. When the print menu appears on the screen, click Print to print your merged 
document. 

Note: If you have any questions concerning the use of Mail Merge or the operation of 
Microsoft Word, please consult the Microsoft Word manual or Word’s help. 
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LOAD AN EXISTING MAIL MERGE 

1. Click Merge on the main menu. 

 

The Mail Merge window is displayed. 
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2. Click to select the Load Saved Search Results option to load a previously 
saved set of guest records. 

 

3. Choose a data source. 

Note: The data source must be saved to Innform\MERGE\DATA.  

If the data source you 
want to use: 

Then do this: 

Was previously saved Select it from the list of saved search results. 

Is not listed  Click Browse to select it.  

 

 

  

Choose a data source from 
the list of saved search 
results or click Browse to 
select a different data 
source.  
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4. Click Open. 

 

5. Click Next. 
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6. Click to select the Load a saved merge document option to load a previously 
created Microsoft Word document (for example, the guest letter). 

 

7. Select the filename of the saved Microsoft Word document. 

8. Click Finish to start the merge process in Microsoft Word. 

9. Click Merge to. 

10. Select Printer under Merge to. 

11. Click Merge. 

12. When the print menu appears on the screen, click Print to print your merged 
document. 
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Reports and Charts 
Use the reports function to create both reports and charts based on a set of guest 
records. There are four different report categories, and each category can be broken 
down by a subcategory of ZIP code, city, state, and market code. 

These are the categories of the reports/charts: 

This report/chart: Shows this… 

Total Revenue The amount of room revenue collected by subcategory 

Average Daily Rate The average room rate per night by subcategory 

Total Nights The total number of room nights rented by subcategory 

Average Length of Stay On average, how many nights the guest stayed by 
subcategory 

 

Note: The amounts shown in Innformer are for marketing purposes only. Please use the 
reports in Check-Inn for financial purposes. 
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CREATE REPORTS AND CHARTS IN INNFORMER 

1. Enter search criteria on the main menu and press Start. 

See Search for more information.  

2. Click Reports on the main menu. 

 

The Reports & Charts window is displayed. 
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3. Use the Report Type drop-down arrow to select the category of report and/or 
chart that you wish to create. 

 

4. Use the Listed By drop-down arrow to select the subcategory of the chart and/or 
report. 
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5. Click to select the report and /or chart check box to indicate which you want to 
print.  

 

6. Click Create to create the report and/or chart. 

 

 

  

Select both check boxes 
to print a report and a 
chart. 
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Note: If you are creating a report and/or chart that includes the subcategory of Market 
Code, you will be asked to select the market codes of interest on the next screen. Use 
the drop-down arrow to select the market codes, and click Continue. 

 

 

When you return to the Reports & Charts screen, click Create.  
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Help 
Use the Help tab to view information about your version of Innformer. 

1. Click Help on the main menu. 

 

The Innformer window is displayed. 
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Frequently Asked Questions 
Q. Why do some of the guest records on the screen appear in red? 

A. These are guest records that have been marked as “bad guests.” 

Q. Why does Innformer require Microsoft Word to function? 

A. We decided that the use of Microsoft Word would allow our clients to have a more 
robust program with which to create their documents. 

Q.  How do I change the fields that display on the main menu? 

A. Click Search at the top of the main menu and select View Options. 

Q. Why can’t I have Microsoft Word running when I am using the merge functions? 

A. You are controlling Microsoft Word through Innformer. In doing this you could 
accidentally close other Word documents that are open. 

Q. Why does Check-Inn rebuild its index after changes have been made to guest 
records in Innformer? 

A. Check-Inn must rebuild the index to reflect the changes made through Innformer. 

Q. Why can’t I run Check-Inn while I am editing a guest record with Innformer. 

A. You might change a guest record that is in use in Check-Inn. 

 

 

 


